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The Storyboard helps you plan the shots that will best tell your story

The Bring Video In tab lets you transfer your footage from the videotape to your
computers hard disk

The Edit tab is where you create and edit your movie using the following subtabs:

•The Viewer tab lets you view you movie and rearrange and adjust the length
of scenes
•The Effects tab gives you the tools to create special effects that smooth the
transitions between scenes
•The Titles tab enables you to create titles, format them and make them scroll
•The Sound tab lets you add music, record narration, or adjust a clip's sound
level
•The Library tab allows you to import media into your movie, such as:
QuickTime movies (.mov), music tracks, animation, photos and graphics

The Send Movie Out tab lets you preview your movie full screen, record it onto
videotape, or save it in a file that you can send over the Internet, put on CD-ROM,
or use in another application

Avid Cinema: An Overview

The Avid Cinema on-screen tabs lead you through the movie making process
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Using Avid Cinema

Starting:
1.  Double click the Avid Cinema icon

2. Click on the icon to:

•Start a new movie by planning it.  Use a storyboard to
provide ideas on what shots to use to best tell your story.
Then bring the video into your computer and edit you
movie.
•Start a new movie by bringing video into your computer,
then edit your movie

•Open and continue editing a movie file already on your
computer.

1. Choose open from the file menu
2. Choose the movie from the file list
3. Click open
       The movie opens in the Avid Cinema tab where
you were last editing and allows you to continue
working on the movie  (if you saved your work)

4



The storyboard is used to make an overall plan of your movie.  A description
of each shot to be used in the movie can be made to guide the process of
creating the final movie.   You can use existing storyboard templates
provided with Avid Cinema, or create your own.

Using the Storyboard 5



A shot is one continuous clip or take for your movie

A shot’s filming tips give you information for
shooting the movie.

A shot’s editing tips give you ideas for editing the
shot, including any effects, titles, music, and
narration to add.

New Shot button - Adds new shots to the
Storyboard.

A good plan is to think about what you want your finished
project to look like in terms of the sequence and duration of
shots. Then enter the information into the storyboard. That
way, when you bring the video into the computer you can
bring it in shot by shot, and your shots will already be
conveniently named. You can always re-arrange the
sequence of shots, add or delete shots or rename shots later.
You will also have the opportunity to add effects and titles
after the video is in your computer.

You can print out your storyboard by clicking on the
Storyboard tab, and then the PRINT command found
under the FILE menu

Storyboard

Tip!
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Connecting a video camera or VCR to your computer

S-video format:  Delivers highest image quality. Use this format if
your camcorder can handle SVHS tapes, or if your camera has an S-
video port and you are recording straight into the computer.

Composite video format: Standard type of video connection found
on nearly all VCR’s and camcorders.  The cables used fore
connections are called RCA cables

Your computer
will also have
video and
Audio out portsRCA video cable (not being used)

S-video in

S-video cable

Audio out
(red and white)

Audio in

Bringing Video into your computer

Once you have filmed your movie, you can bring it into the computer
to edit.
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Use these buttons to start and stop bringing
in a shot

This indicator shows you the audio level as you
play the video. For best results the audio should
stay in the green and yellow range.

Video requires a lot of disk space, so just bring in the shots you need.

Be sure to select the video source type.

Video

Tip!
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When your VCR or camcorder is connected to the computer, you are ready to
bring in your video

1.  Play the videotape to find the shot you want.  Rewind the tape and stop
about 20 seconds or so before the shot you want.

2. Choose the shot you want from your storyboard list, or click on the new
shot button to create a shot. If you have a storyboard for your movie, the
shots are listed here. You can select each shot, and bring in video for it. As
you bring in the shot, a red check mark appears beside that shot.

3. If you click on the new shot button to create a shot, be sure to give it a
unique and identifiable name. The storyboard will be created as you continue
along in this manner.

Opening Shot
A swaying plant
Stems
Flowers
Roots
Leaves
closing Shot
Credits
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4. If you want to bring the video in without sound, click on the mute button

5. Play the tape using your controls on your camcorder

6. Click Record.
The Record button flashes and the mouse pointer changes to a

scrolling tape to let you know you are bringing video in.

7. Click Stop a second or so after the video you want ends.

8. Choose Save from the File menu

Each new Avid Cinema movie and project has a media folder where all of the
video, music, and voice clips for that movie are stored.  The name of the folder
is “movie” Media, and it is created in the folder where you save your new
movie.

All clips in your Media folder are included in your movies library, even those
that are not currently being used in the timeline.  You can see all of the clips
by clicking on the Library tab.
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Editing your movie

You will use the Edit Movie tab to access the features necessary to
edit and work with your movie

The Next and Previous buttons let you display the next or
previous image (called a frame) in the clip

The Volume button lets you adjust the volume of your movie.
It controls how loud your movie will play when you publish it.

The Position bar in the viewer works in sync with the Position
bar in the timeline.  They both move to the same frame in your
movie.  You can click on the bar and drag it to any clip you
choose.
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The Viewer tab is where you view your movie and do basic editing,
including reorganizing clips, trimming (shortening clips), splitting clips, and
removing whole clips or portions of them.

The Viewer Tab

In the Viewer window you can play
your movie or view any frame (still
image) in it.

Editing is done in the Timeline.  In addition to the video track, the Timeline has
tracks for titles, voice, and music.  You will click on the other tabs found in the Edit
Movie window to add these features.
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You can reorganize clips in the Timeline, by selecting a clip and
dragging it left or right to anew location. When the correct location is
highlighted with a red pointer, drop the clip.

You can insert black into your timeline by selecting the clip following
the cut where you want to insert black

Choose Insert Black from the Movie menu

Insert Black
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Special Effects

Special effects create seamless transitions from one clip to the next. Effects can
create subtle, yet powerful images, and they can hide production errors.
Dissolves are the most frequently used effects, because they are the least
distracting to viewers.

The Effect Duration handle lets you adjust the length of the effect you are about
to create.
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Effects

The Effect Previewer gives you an idea of how the effect you have chosen
will look when you apply it.

After you apply the effect you will see a bar appear on the timeline
indicating the transition where you created the effect.
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Adding Text or Titles to you Movie
The Titles tab lets you superimpose text, called titles over your movie.  Titles
can be still images (captions), or scrolling images (credits that scroll up, down,
or from left to right).

Change font

Make selected text bold, italic, or underlined.

Align selected text to the left margin, center of the
page, or right margin

Change size

Set scrolling direction

  Change color of text

Apply Title effect
Remove selected
Title effect
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Adding Sound to your Movie 

You can record audio along with your original film clip or you can add
audio to the movie after the clips are place onto the timeline.

Record narration over parts of
your  movie

Add sound tracks from music CDs to your movie
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In the Sound tab you can adjust the volume of the video, voice, or music
clip.  You can also set the fade option to have the sound fade in and fade out

Adding Narration:
1. If you computer does not have a built in microphone, plug one in.
2. Choose Audio Source from the Movie menu, then select Sound In or
Built In Mic from the Audio Source menu
3. In the timeline, drag the Position bar to the place where you want the
narration to begin
4. Click Record, and narrate the movie. The movie plays as you narrate.

5. Click Stop when you are done.  A narration clip appears in the voice track.
6. Review your clip in the Viewer window. If you are unhappy with your
narration, choose Clear from the Edit menu, and try again.

To use the fade option,
place the Position bar over
the clip you want to fade.
Click the Fade In or Fade
out buttons next to the
track for each sound clip
you want to fade
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Adding music to your movie:
The simplest way to add music to your movie is to “import” it from a
music CD in your computers built in CD drive.

You can also record sound from an audio cassette player, portable CD
player, VCR, or another sound device with RCA audio ports such as a
music synthesizer.

To import music from the built in CD player, place a CD in
your computers CD player

1. Click on the Sound tab
2. In the timeline place the Position bar where you want the music to
begin

3. Click on the Import button

4. Choose the music track you want
5. Click Open
6. Use the slider to adjust how much of the track you want to import, and
click the play button to listen
7. Click OK when you are satisfied. The music is imported into the
Music track of the timeline
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The media Library

List: Get a list of the video, music, and voice clips
in your movie
Preview: Preview any of the clips in the Viewer
window

Add movie clips, scanned images, online pictures, and music
CD tracks to your movie library
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Preparing the Final Movie

You can send your completed movie out to videotape, or prepare it
for deliver over the internet.  Your movie needs to be prepared first.
This will built all the necessary effects, sounds, and transitions into
one movie file.

To preview your movie on the full screen:

1. Click the Preview full-screen button
2. Click the Start button

--If your movie does not contain any titles, this plays your movie on
the full screen.  If there are titles, this prepares your movie for publishing by
incorporating the titles into the video track

--Once your movie is prepared click the Start button once again
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Making a videotape

1. Make sure your cables are connected to the video and audio out
ports on you computer and that they are connected to the In ports of
your VCR.
2. Set your VCR’s input to AUX or LINE
3. Select the television icon on your control strip, then select
Overscan, followed by Turn TV Mirroring On

4. Insert a blank video tape into your VCR.
Press the Record buttonon the VCR
5. Click the Start button to transfer the the movie to videotape
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Video and

Filming Tips

•Always include an extra 3-5 seconds at the beginning and end of your video

•If you plan to use a video camera to record shots, try to use a tripod.  Some cameras have a
stabilization feature that compensates for camera shake.

•While recording live video, move the camera very slowly.  If your camera has an autofocus
feature, you may need to turn it off.

•Avoid filming objects that are very close, and then moving quickly to an object far away.  The
autofocus feature of your camera may not be able to make the transition in a smooth manner.
Practice the shot using the manual focus feature of your camera

•Use a variety of shots to document a long story

•Change the camera angle or distance to the subject for each shot.

•Put the main light source behind you and to one side of you, so that it lights the subject
without throwing your shadow into the picture

•Make sure the subject is well lit. Avoid strong shadows on the subject

•The best shot to show who is in the video is a close up.
•A shot that shows important details, can be an extreme close-up.
•Shots that remind the audience where the story takes place are called cutaways. These are
usually medium close-ups

The greater the variety of shots in your movie, the more interesting the movie
will be to your viewers. Increase variety by changing your camera angle for each
shot.  Move your camera to film your subject from above or below, or from the
left or the right.

Run the camera longer for subjects that take a longer time to understand and
shorter times for those can be understood more quickly.
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